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การเรียกใช้โปรแกรม SketchUp 2016  
 
หลงัจากติดตั้งโปรแกรม SketchUp สามารถเรียกใชโ้ปรแกรมโดยมีขั้นตอนดงัน้ี 

1. คลิกเขา้สู่โปรแกรม SketchUp 2016 > SketchUp หรือ ดบัเบิลคลิกไอคอน SketchUp 2016 ที่หนา้จอ (Desktop) 

 

 

            

 
2. เม่ือเปิดโปรแกรมจะปรากฏไดอะล็อคบร็อกซ์ “Welcome to SketchUp” ซ่ึงเป็นการตั้งค่าการท างานเบื้องตน้ของ
การท างาน หากเขา้สู่โปแกรมเลือก Start using SketchUp  
 
 

 

 

ในขั้นตอนน้ีผูใ้ชส้ามารถกรอกช่ือผูใ้ชแ้ละรหสัที่ไดจ้ากตวัแทนจ าหน่ายเม่ือสัง่ซ้ือโปรแกรม โดยการคลิก 

ไปที่ Add License กรอกขอ้มูลทะเบียนผูใ้ช ้หากไม่กรอกทะเบียนผูใ้ช ้จะยงัคงใชโ้ปรแกรมในรุ่นทดลองใช ้ซ่ึงจะมี

บางค าสัง่ถูกลดทอนลง 

ลงทะเบียน 

เลือก Template หน่วยวดัและการแสดงภาพ 

สถานการณ์ลงทะเบียน 
เลือก Template หน่วยวดัและการแสดงภาพ 

 
เข้าสูก่ารแสดง 
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เม่ือเลือก Start using SketchUp จะเขา้สู่หนา้จอท างานของโปรแกรม (หมายเหตุ: สีของฉากหลงัเปล่ียนไป
ตามการตั้งค่าหน่วยวดัซ่ึงสามารถตั้งค่าไดอี้กคร้ัง) 

 

 

นอกจากนั้นยงัสามารถตั้งค่าหน่วยวดัที่ใชใ้นการสร้างโมเดลวา่จะใชรู้ปแบบใด เช่น เมตร ฟุต น้ิว โดยการ
เลือกที ่Template จากนั้นเลือกหน่วยวดั 

 

เม่ือเลือก Start using SketchUp จะเขา้สู่หนา้จอท างานของโปรแกรม (หมายเหตุ: สีของฉากหลงัเปล่ียนไป
ตามการตั้งค่าหน่วยวดัซ่ึงสามารถตั้งค่าไดอี้กคร้ัง) 
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3. เม่ือเขา้สู่การท างานของโปรแกรม สามารถเรียกเคร่ืองมือ (Tools) เพือ่สร้างช้ินงาน โดยไปที่ View > Toolbar > 
Large Tool Set เคร่ืองมือส าหรับการสร้างช้ินงาน จะปรากฏในหนา้ต่างการท างาน นอกจากการเรียกชุดคาสัง่ส าหรับ
ช้ินงาน แลว้ยงัสามารถเรียกเคร่ืองมืออ่ืน ๆ เพือ่ใหก้ารท างานมีความรวดเร็วมากยิง่ขึ้น  
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หน้าต่างของโปรแกรม SketchUp 2016 

ก่อนที่จะเร่ิมท างานกบั SketchUp 2016 เรามาท าความรู้จกักบัส่วนประกอบของโปรแกรม ซ่ึง SketchUp มี

ส่วนประกอบที่เรียบง่าย ดูไม่ซบัซอ้น 

หน้าจอหลกั (Main Screen) 

 

 

 ไตเติล้บาร์ (Title bar) : แสดงช่ือไฟลท์ี่กาลงัใชง้านอยู ่ 
 เมนูบาร์ (Manu bar) : แถบรวมค าสัง่ทั้งหมด  
 ทูลบาร์ (Toolbar) : แสดงเคร่ืองมือหลกัในการวาดและปรับแต่งโมเดล  
 พืน้ทีก่ารท างาน (Drawn area) : เน้ือที่ท  างาน แสดงผลเป็น 3 มิต ิ 
 จุด Origin และแกนวาด : จุดเร่ิมตน้และแกนวาด 3 แกน ไดแ้ก่ แกนสีแดง, เขียว และน ้ าเงิน  
 ส่วนแสดงข้อมูลโมเดล : แสดงขอ้มูลโมเดล วธีิใชเ้คร่ืองมือต่าง ๆ  
 Measurement bar : ใชแ้สดงขนาด ระยะทาง และใชส้ าหรับพมิพก์ าหนดค่า ซ่ึงหน่วยวดัจะเปล่ียนแปลงไปตาม

เคร่ืองมือที่ใชอ้ยู ่

 ไดอะล็อกบ็อกซ์ (Dialog Box) : เคร่ืองมือปรับแต่งแกไ้ขรายละเอียดการท างานเพือ่เพิม่ความสามารถในหลาย
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ดา้น เช่น การตั้งค่าแสงสวา่ง (Shadow Setting) การเลือกวตัถุสาเร็จรูป (Component) การใส่สีและพื้นผวิ (Paint 
Bucket) เป็นตน้ 

เส้นแกน (Axes)  
การท างานกบัโมเดล 3 มิติ นอกจากมุมมอง ในการดูต าแหน่งต่าง ๆ แลว้ แกนก็ถือวา่เป็นเร่ือง ที่จ  าเป็นตอ้ง

ใช ้เพราะเป็นตวัช่วยในการวางต าแหน่ง และก าหนดทิศทางต่าง ๆ ขณะวาด  
ในการสร้างโมเดลอาคารสถานที่ แต่ละแกนจะแสดง 

ทิศทางต่างๆ กนั ดงัน้ี 
 

 แกน x เส้นทึบสีแดง จะโยงไปทางทิศตะวนัออก  
 แกน x เส้นปะสีแดง จะโยงไปทางทิศตะวนัตก  

 แกน Y เส้นทึบสีเขียว จะโยงไปทางทิศเหนือ  

 แกน Y เส้นปะสีเขียว จะโยงไปทางทิศใต ้ 

 แกน Z เส้นทึบสีน ้าเงิน จะโยงไปขึ้นไปบนทอ้งฟ้า  

 แกน Z เส้นปะสีน า้เงิน จะโยงลงไปใตร้ะดบัพื้นดิน  
 

จะเห็นวา่เสน้แกนจะมีส่วนที่เป็นเสน้ทึบและเสน้ปะ และมีส่วนที่ตดักนัจะเรียก  
จุดนั้นวา่จุดฐานรูปทรงอา้งอิง (Shape Inference) ของแกน หรือ จุด Origin ซ่ึงเป็นจุดเร่ิมตน้ ในการวาดช้ินงาน  

 

ต าแหน่งอ้างองิบนโมเดล  
ขณะที่ใชเ้คร่ืองมือวาดรูปทรงต่าง ๆ นั้น จะเห็นขอ้ความแสดงต าแหน่งของส่วนต่าง ๆ ภายในโมเดล 

เรียกวา่ ต ำแหน่งอ้ำงอิง เม่ือเล่ือนเมาส์ไปบนต าแหน่งต่าง ๆ เมาส์จะแสดงสญัลกัษณ์ ที่แตกต่างกนั และมี ทูลทิป 

(Tooltips) บอกต าแหน่งใหด้ว้ย ต าแหน่งอา้งอิงในโมเดลนั้นแบ่งออก เป็น 3 ประเภท ไดแ้ก่ จุดอา้งอิง (Point 

Inference), เสน้แนวอา้งอิง (Linear Inference) และรูปทรงอา้งอิง (Shape Inference) 

จุดอ้างองิ (Point Inference) 

เม่ือเล่ือนเมาสไ์ปบนโมเดล จะเห็นจุดอา้งอิงแสดงในต าแหน่งต่าง ๆ ดงัน้ี 
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Endpoint : เคอร์เซอร์อยูใ่นต าแหน่งปลายเสน้หรือปลายเสน้ขอบของ
วตัถุ 

 

Midpoint : เคอร์เซอร์อยูใ่นต าแหน่งก่ึงกลางเสน้ หรือก่ึงกลางเสน้ขอบ
ของวตัถุ 

 

Intersection : เคอร์เซอร์อยูใ่นต าแหน่งที่มีการตดักนัของเสน้ 

 

On Face : เคอร์เซอร์อยูใ่นต าแหน่งพื้นผวิของวตัถุ 

 

On Edge : เคอร์เซอร์อยูใ่นต าแหน่งบนเสน้ขอบของวตัถุ 

 

เส้นแนวอ้างองิ (Linear Inference) 

On Axis : เสน้มีสีแตกต่างกนั 3 สี  
สีแดง วางตวัในแนวแกน X  
สีเขียว วางตวัในแนวแกน Y  
สีน้าเงิน วางตวัในแนวแกน Z  
Parallel to Edge : วาดเสน้โดยขนานไปกบั วตัถุที่อยูใ่กล ้ 
Perpendicular to Edge : ขณะวาดเสน้ตั้งฉากกบัเสน้ขอบที่เราเร่ิมตน้วาด  
Form Point : ขณะที่วาดเสน้ต าแหน่งเคอร์เซอร์ ไปอา้งอิงกบัต าแหน่งของเสน้อ่ืน ๆ จะเกิดเป็นเสน้ปะ 
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การบันทึกไฟล์งาน 

ถา้ตอ้งการเก็บไฟลไ์วห้ลงัจากสร้างงานแลว้ สามารถบนัทึกไฟลเ์ก็บไวเ้รียกใชภ้ายหลงัได ้ 
โดยไฟลท์ี่ไดจ้ะมี น ำมสกุล .skp มีขั้นตอนดงัน้ี 
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การท างานกบัวตัถุ 3 มิตินั้น จะมีมุมมองที่รอบดา้นแตกต่างจากวตัถุ 2 มิต ิดงันั้นเคร่ืองมือเก่ียวกบัมุมมอง
ช้ินมาก็ตอ้งมีหลายอยา่ง เพือ่ความเหมาะสมกบัการดูช้ินมาแต่ละมุม โปรแกรม SketchUp มีเคร่ืองมือมุมกลอ้ง ซ่ึง

จ  าลองมุมมองเหมือนอยูใ่นสภาพแวดลอ้มของช้ินงานจริง เช่น การมองดูหรือการเดินผา่นช้ินงานที่เป็นสถานที่ 

 

มุมมองมาตรฐาน Standard View 

ในพื้นที่ 3 มิติจะมีมุมมองมาตรฐานในการมองช้ินงานอยู ่7 มุม ไดแ้ก่  
 Top : ดา้นบน 

 Bottom : ดา้นล่าง (ขา้งใต)้ 

 Front : ดา้นหนา้ 

 Back : ดา้นหลงั 

 Left : ดา้นซา้ย 

 Right : ดา้นขวา 

 ISO : Isometric หรือมุมมองแนวเอียงที่ท  าใหเ้ห็นรูปทรงโดยรวมของช้ินงานได ้ 
 

 

 

 

 

 

 

 

การเลอืกมุมมองมาตรฐานอย่างรวดเร็ว 

ในการมองช้ินงานมุมต่าง ๆ นั้นเราสามารถใชเ้คร่ืองมือหมุนมุมมอง เพือ่มองรอบช้ินงานไดอิ้สระ แต่

มุมมองมาตรฐานมีประโยชน์ส าหรับการตรวจสอบช้ินมาในแต่ละดา้นอยา่งเที่ยงตรง และ ใชใ้นการน าเสนองาน 
เช่น การออกแบบสินคา้ หรือสถานที่ต่าง ๆ การเลือกมุมมองมาตรฐาน ท าไดด้งัน้ี 
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1. เลือกเมนู Camera จากแถบเมนูหลกั และเลือกมุมมองจากเมนูยอ่ย Standard Views 

 

2. พื้นที่ท  างานจะเปล่ียนเป็นมุมมองที่เลือกไวต้ามภาพตวัอยา่ง 
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การเคลือ่นมุมมองรอบวตัถุ Orbit 

 เคร่ืองมือ Orbit มีไวส้ าหรับการหมุนมุมมองรอบช้ินงานในลกัษณะการโคจรรอบ ๆ นบัวา่ เป็นเคร่ืองมือที่

จ  าเป็นตอ้งใชต้ลอดเวลาในการสร้างโมเดล 3 มิต ิและเคร่ืองมือ Orbit น้ีมกัใชค้วบคู่กบัเคร่ืองมือ Pan ซ่ึงจะแนะน า
ในหวัขอ้ต่อไป 

การมองรอบ ๆ ช้ินงานด้วย Orbit  
การเรียกใชเ้คร่ืองมือ Orbit นั้นทาใดจ้ากการเรียกใชเ้มนู และการใชเ้มาส์เพือ่ความรวดเร็ว ดงัน้ี 

1. คลิกเลือกเคร่ืองมือ Orbit บน Toolbar 

 

 

2. ใชเ้คร่ืองมือ Orbit คลิกเพือ่หมุนมุมมองช้ินงานไดร้อบ 360 องศา ส่ิงที่หมุนคือมุมมองของเรา แต่ไม่ใชว้ตัถุ
ที่ถูกหมุน 
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การเลื่อนมุมมองแนวราบ Pan 

เคร่ืองมือ Pan ใชส้ าหรับการเล่ือนมุมมองแนวราบโดยไม่หมุนมุมมอง จะเห็นไดว้า่หนา้ที่ของ Pan และ 
Orbit นั้นเป็นการจดัการมุมมองช้ินงานที่ต่างแนวกนั แต่ตอ้งใชคู้่กนัเสมออยา่งหลีกเล่ียงไม่ได ้ดงันั้น 2 เคร่ืองมือน้ี
จึงเป็นเคร่ืองมือที่เราเรียกใชไ้ดทุ้กเวลาโดยไม่จ าเป็นตอ้งคลิกเลือกเคร่ืองมือจาก Toolbar ก่อนทุกคร้ัง  
เรามาดูวธีิใชง้าน Pan Tool ทั้งจากการคลิกที ่Toolbar และการใชง้านดว้ยเมาส์ 

1. จากตวัอยา่งช้ินงานจะอยูเ่รียงกนัในแนวหนา้กระดาน 

 

 

2. คลิกเลือกเคร่ืองมือ Pan บน Toolbar 

 
3. ใชเ้คร่ืองมือ Pan คลิกและเล่ือนมุมมองในแนวราบเพือ่ท  างานกบัช้ินงานแต่ละช้ินได ้การเล่ือนน้ีเป็นการ

เล่ือนมุมมอง แต่วตัถุไม่มีการเคล่ือนยา้ยแต่อยา่งใด 
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การขยายมุมมอง Zoom 
เคร่ืองมือ Zoom นบัวา่เป็นเคร่ืองมือจดัการมุมมองที่มีหนา้ที่สาคญั คือการยอ่และขยายมุมมอง เพือ่ท  างาน

กบัช้ินงานในระดบัภาพรวมหรือในรายละเอียดยอ่ย ๆ ได ้เคร่ืองมือ Zoom ไม่เพยีงแต่ใชใ้นการยอ่ขยายมุมมอง
เท่านั้น แต่ยงัใชเ้ปล่ียนมุมกลอ้งไดอี้กดว้ย 

การเรียกใช้เคร่ืองมอื Zoom  
การเรียกใชเ้คร่ืองมือ Zoom จาก Toolbar มีดงัน้ี 

 

 คลิกเล่ือนไปทางดา้นบนเป็นการขยายมุมมองช้ินงานจะดูใกลแ้ละใหญ่ขึ้น 

 คลิกและเล่ือนไปทางดา้นล่างเป็นการยอ่มุมมอง ช้ินงานจะดูไกลออกไปและเล็กลง 

 หากดบัเบิลคลิกเคร่ืองมือ Zoom ไปที่วตัถุใด วตัถุนั้นจะถูกจดัใหอ้ยูต่รงกลาง 
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Zoom Window  
Zoom Window เป็นเคร่ืองมือที่อยูใ่กลเ้คียงเคร่ืองมือ Zoom และใชง้านใกลเ้คียงกนัดว้ย เพยีงแต่เคร่ืองมือ Zoom 

Window จะใหล้ากพื้นที่ที่ตอ้งการจะขยายมุมมองโดยเฉพาะ วธีิใชแ้ละตวัอยา่งผลลพัธมี์ดงัน้ี 

 

ลากพื้นที่ที่ตอ้งการขยายมุมมอง ผลลพัธ ์คือมุมมองจะถูกขยายในบริเวณที่ลากพื้นที่จนเตม็หนา้จอการท างาน 

Zoom Extents  
Zoom Extents มีหนา้ที่ขยายมุมมองเพือ่ใหเ้ห็นช้ินงานทั้งหมดบนพื้นที่ท  างาน โดยมีมุมมองที่ใหญ่ที่สุดเท่าที่จะ

ครอบคลุมช้ินงานทั้งหมดนั้น 

 

ช้ินงานทั้งหมดจะถูกขยายจนเตม็พื้นที่การท างาน 

 

การเลือกส่วนประกอบโมเดล สามารถเลือกดว้ยการใชเ้คร่ืองมือ Select โดยท าไดห้ลายวธีิขึ้นอยูก่บัลกัษณะ

งาน ดงันั้นจึงจ าเป็นตอ้งรู้จกัเทคนิคในการใชเ้มาส์ และคียบ์อร์ด เพือ่เลือกส่วนประกอบที่ตอ้งการ 

การเลอืกด้วยการคลกิเมาส์หลายคร้ัง 

ดว้ยการคลิกเมาส์อยา่งเดียว เราสามารถเลือกส่วนต่างๆ ของวตัถุได ้แต่เราควรทราบก่อนวา่วตัถุช้ินหน่ึง

ประกอบดว้ยอะไรบา้ง 
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เม่ือทราบองคป์ระกอบของวตัถุแลว้ การเลือกส่วนต่างๆ ของวตัถุดว้ยเมาส์ มีดงัน้ี 

 

 
 
การคลิก 1 คร้ัง บนดา้นใดดา้นหน่ึง  
จะเป็นการเลือกเฉพาะพื้นผวิของดา้นนั้น  

และจะปรากฏไฮไลทพ์ื้นผวิที่เลือก 

 

 

  
การคลิก 2 คร้ัง หรือดบัเบิลคลิก  
     จะเป็นการเลือกพื้นผวิและเสน้ขอบพื้นผวินั้น  

     จะมีไฮไลทป์รากฏทั้งพื้นผวิ และเสน้ขอบ 

 

 

 

 การคลิก 3 คร้ัง หรือทริปเปิลคลิก  
จะ เป็นการเลือกวตัถุทั้งช้ิน หรือมีความหมายวา่  
เลือกพื้นผวิและเสน้ขอบทุกดา้นที่เช่ือมต่อกนั  
ของวตัถุช้ินนั้น จะมีไฮไลทป์รากฏทั้งช้ินวตัถุ  
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การเลอืกวตัถุหลายช้ินด้วยการลากพืน้ทีเ่มาส์ 

การลากพื้นที่เมาส์เพือ่เลิกวตัถุหลายช้ินนั้นมีวธีิที่สะดวกรวดเร็ว เพยีงเราเขา้ใจในหัวขอ้น้ี เราก็เลือกวตัถุได้

อยา่งง่าย 

 

การลากพื้นที่ดว้ยเมาส์จากซา้ยไปขวา จะปรากฏกรอบส่ีเหล่ียมเสน้ทึบซ่ึงจะเป็นการเลือกวตัถุที่อยู่
ภายในกรอบการลากพื้นที่เท่านั้น วตัถุใด ที่ไม่อยูใ่นกรอบเตม็ช้ินก็จะไม่ถูกเลือก 

 
 

การลากพื้นที่ดว้ยเมาส์จากขวาไปซา้ย จะปรากฏกรอบส่ีเหล่ียมเสน้ปะ ซ่ึงจะเป็นการเลือกวตัถุที่กรอบ
เสน้ปะนั้นพาดโดน แมไ้ม่ไดค้รอบวตัถุทั้งช้ิน แต่ถา้กรอบเสน้ปะไปถึง วตัถุนั้นก็จะถูกเลือกดว้ย 
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การเลอืกวตัถุทั้งหมดและการยกเลกิการเลอืก  
เราสามารถเลือกวตัถุทั้งหมดในไฟลโ์ครงการที่เปิดอยูข่ณะนั้นได ้และยกเลิก การเลือกทั้งหมดได ้เช่นเดียวกนั  
การเลือกทั้งหมด กดปุ่ ม <Ctrl> + A บนคียบ์อร์ด หรือเลือกเมนู Edit >Select All  

 

 

 

เคร่ืองมือลบวตัถุ Eraser 

เคร่ืองมือ Eraser    ใชล้บเสน้, ช้ินส่วน, กรุ๊ป หรือคอมโพเนนต ์นอกจากน้ียงัใชซ่้อนเสน้ที่ไม่ตอ้งการ 
หรือทาพื้นผวิให้เรียบขึ้นได ้แต่ไม่สามารถลบพืน้ผวิได ้

การลบองค์ประกอบของวตัถุ 

 

ใชเ้คร่ืองมือลบคลิกที่ส่วนใดส่วนหน่ึงของวตัถุ เช่น เสน้ขอบ และปล่อย เพือ่ลบส่วนนั้น  
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ใชเ้คร่ืองมือลบคลิกคา้ง และลากผา่นไปยงัส่วนต่าง ๆ ที่จะลบ ก่อนปล่อยเมาส์เพือ่ลบส่วนที่เลือกไว ้ 
 

 

การลบขอบวตัถุ  
โดยทัว่ไปวตัถุจะมาพร้อมกบัเสน้ขอบเพือ่ใหพ้ื้นผวิเป็นส่วนที่ปิด แต่พื้นผวิก็สามารถอยูไ่ดโ้ดยไม่มีเสน้

ขอบ ซ่ึงจะท าใหพ้ื้นผวิดูเรียบขึ้น เราสามารถลบขอบออกโดยไม่ท าใหพ้ื้นผวิวตัถุหายไปได ้

 เลือกเคร่ืองมือลบ และกดปุ่ ม      คา้ง ขณะคลิกเลือกเสน้ขอบที่ตอ้งการลบ ซ่ึงเลือก ไดค้ร้ังละหลาย
เสน้ 

 

 การท าใหพ้ื้นผวิมีเสน้ขอบกลบัมาเหมือนเดิม ใหใ้ชเ้คร่ืองมือยางลบเช่นเดิม และกดปุ่ ม  +   
ขณะลากเมาส์ผา่นพื้นผวิ และปล่อย 
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เคร่ืองมือเทสีพื้นผวิวตัถุ Paint Bucket 

โปรแกรม SketchUp ก าหนดพื้นผวิวตัถุใหมี้สีและคุณสมบติัต่าง ๆ ได ้เช่น โปร่งใส เป็นตน้ ซ่ึงจะใช้
เคร่ืองมือช่ือ Paint Bucket ในการท างาน 

1. คลิกเลือกเคร่ืองมือ Paint Bucket 

 
2. หนา้ต่าง Materials จะปรากฏขึ้นมา ซ่ึงเป็นที่รวมสีและพื้นผวิเพือ่เลือกใช ้

 
3. เลือกสีที่ตอ้งการใช ้ในตวัอยา่งจะเลือกสีแดง 
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4. คลิกเลือกพื้นผวิส่วนที่ตอ้งการ เพือ่เปล่ียนสีวตัถุช้ินหน่ึง อาจจะมีพื้นผวิหลายส่วนที่ไม่ไดเ้ช่ือมต่อกนั 
ท าใหต้อ้งคลิก เทสีในแต่ละส่วนเอง 

 

การใส่สีพืน้ผวิให้กบัวตัถุ  
การใส่คุณสมบติัพื้นผวินั้น ท าโดยวิธีเดียวกบัการเลือกสีแลว้เทบนพื้นผวิ เพยีงแต่เลือก ในหมวดพื้นผวิเท่านั้น ใน

ตวัอยา่งน้ีจะท าการก าหนดใหก้ระจกรถยนตมี์สีโปร่งใส 
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3.  คลิกเทสีบนพื้นผวิที่ตอ้งการ ไดแ้ก่ กระจกรอบคนัรถ          4. หมุนวตัถุดว้ยเคร่ืองมือ Orbit หรือ    

                  คลิกเมาส์ปุ่ มกลางแลว้หมุน 

         

5. เทสีกบักระจกอีกดา้นจนรอบคนั 

 

2. เลือกตวัเลือกทีมี่ช่ือวา่ Glassซ่ึงพื้นผวิวตัถุไว ้    มี

สีต่าง ๆ เลือกใชต้ามที่ชอบได ้กบัวตัถุซ่ึงหมวดของ
พื้นผวิโปร่งใสจะมีช่ือวา่ Translucent 

1.ในหนา้งต่าง Materials จะมีการแบ่ง

หมวดหมู่ ในรายการ Drop down list 
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ชุดเคร่ืองมือ Drawing 

ชุดเคร่ืองมือ Drawing จะแสดงรวมอยูบ่นแถบเคร่ืองมือ Large Tool Set หากตอ้งการ แสดงชุดเคร่ืองมือ 
Drawing ขึ้นมาต่างหาก ใหค้ลิกเมนู View > Toolbar > Drawing ซ่ึงจะมีเคร่ืองมือสาหรับวาดภาพในแนวระนาบ 

ดงัน้ี 

 

 

เคร่ืองมือวาดเส้นตรง Line 

เสน้เป็นองคป์ระกอบพื้นฐานของวตัถุต่าง ๆ เราสามารถวาดเสน้บนพื้นผวิวตัถุ หรือบนพื้นที่วา่งก็ได ้
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การวาดเสน้ที่ต่อเน่ืองกนัไปเร่ือย ๆ จนส้ินสุดที่จุดเร่ิมตน้จะเป็นการสร้างพื้นที่ปิด ซ่ึงสามารถใชเ้ป็นวตัถุ 

เพือ่สร้างงานต่อไปได ้
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เคร่ืองมือวาดเส้นอสิระ Freehand 

เคร่ืองมือวาดเสน้อิสระมีไวใ้ชว้าดเสน้ดว้ยมือ (เมาส์) ของเราเอง โดยที่ไม่จาเป็นตอ้งเป็นรูปทรงเรขาคณิต 
และไม่ตอ้งค  านึงถึงปัจจยัใด ๆ เคร่ืองมือวาดเสน้อิสระมีช่ือวา่ Freehand 

 

การแก้ไขรูปทรงอสิระ  
เม่ือวาดรูปทรงอิสระขึ้นมาแลว้ รูปทรงนั้นจะมีโครงสร้างเป็นเสน้ยอ่ย ๆ หลายส่วนที่ต่อกนัจนไดรู้ปทรงที่

เราวาด โดยปกติเม่ือเลือกส่วนใดส่วนหน่ึงของรูปทรงอิสระ จะเป็นการเลือก วตัถุทั้งช้ิน หากตอ้งการแกรู้ปทรง

บางส่วน จะตอ้งท าการแยกส่วนเสน้ต่าง ๆ หรือเรียกวา่ การระเบิด (Explode Curve) 

เคร่ืองมือวาดรูปทรงส่ีเหล่ียม Rectangle 

ส่ีเหล่ียมมุมฉากที่สร้างบนโปรแกรม SketchUp จะประกอบไปดว้ย พื้นผวิที่เกิดจาก เสน้ตรง 4 เสน้เช่ือมต่อ
กนั ซ่ึงการสร้างส่ีเหล่ียมดว้ยเคร่ืองมือ Rectangle  
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การวาดรูปทรงส่ีเหลีย่มด้วยการก าหนดขนาดทีแ่น่นอน  
หากตอ้งการสร้างส่ีเหล่ียมที่มีขนาดดา้นกวา้งและยาวที่ตอ้งการ เราสามารถก าหนดค่าเหล่านั้นไดอ้ยา่งแม่นย  าขณะ

สร้างไดด้งัน้ี 

ขณะลากพื้นที่พมิพค์่าความกวา้งและความยาวตามตอ้งการ เช่น 5m, 5m คือ ก าหนดความกวา้ง 5 เมตร ยาว 

5 เมตร 

      

การวาดรูปทรงส่ีเหลีย่มหมุนระนาบ  Rotated Rectangle  
เป็นเคร่ืองมือใหม่ในเวอร์ชัน่ 2015 สามารถสร้างรูปทรงส่ีเหล่ียมในลกัษณะหมุนระนาบไดด้งัน้ี 

1. คลิกเพือ่ก าหนดมุมแรกของส่ีเหล่ียม 

 
2. เล่ือนเคอร์เซอร์ของไมโ้ปรแทรกเตอร์ เพือ่ก าหนดทิศทางของมุม 
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3. คลิกเพือ่ตั้งค่ามุมที่สอง เล่ือนเคอร์เซอร์เพือ่ก าหนดความยาวของมุม และคลิกเพือ่ตั้งค่ามุมที่สาม เป็นมุม
สุดทา้ย 

 

 

4. เสร็จส้ินการสร้างรูปทรงส่ีเหล่ียมหมุนระนาบ 
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เคร่ืองมือวาดรูปวงกลม 

วงกลมที่สร้างขึ้นบนโปรแกรม SketchUp เกิดจากการเรียงต่อกนัของเสน้ตรงลอ้มรอบ เป็นรูปวงกลม ซ่ึง

สามารถก าหนดจ านวนเสน้ที่เรียงต่อกนั และความยาวรัศมีของวงกลมได ้เราจะใชเ้คร่ืองมือ  Circle สร้างวงกลม
และพื้นผวิบนระนาบ ซ่ึงท าได ้2 วธีิ คือ การสร้างพื้นผวิวงกลมดว้ยการลากเมาส์ และการก าหนดขนาดที่แน่นอน 

การวาดวงกลมด้วยการก าหนดขนาดทีแ่น่นอน  
เน่ืองจากวงกลมใน SketchUp เกิดจากการเรียงต่อกนัของเสน้ตรงลอ้มกนัเป็นวงกลม ดงันั้นขณะที่สร้างวงกลมก็

สามารถก าหนดจ านวนเสน้ตรงที่ประกอบขึ้นเป็นวงกลมได ้โดยค่าเร่ิมตน้ก าหนดไวท้ี่ 24 เสน้ และก าหนดความยาว

รัศมีของวงกลมตามตอ้งการ โดยการก าหนดขนาดต่าง ๆ ของวงกลม ไดด้งัขั้นตอนต่อไปน้ี 

1. คลิกเลือกเคร่ืองมือสร้างวงกลม และคลิกเพือ่สร้างบนพื้นที่ แต่ยงัไม่ตอ้งคลิกเพือ่ปิดการสร้าง 

 

2. พมิพค์่ารัศมี เช่น 5m คือ 5 เมตร ซ่ึงค่าจะแสดงดา้นล่างขวาของหนา้จอ และกด <Enter> 

 
3. พมิพค์่าจ  านวน Sides หรือจ านวนส่วนยอ่ยของเสน้ขอบรวบวง ตามดว้ย s และกด <Enter> 

 
4. เม่ือก าหนดเสร็จจะไดว้งกลมที่มีรัศมีและจ านวน Sides ของเสน้รอบวงตามตอ้งการ 
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เคร่ืองมือวาดรูปทรงหลายเหลีย่ม Polygon 

รูปทรงหลายเหล่ียม คือรูปทรงที่นอกเหนือจากส่ีเหล่ียม ซ่ึงเราก าหนดจ านวนเหล่ียม หรือดา้นเองได ้ตั้งแต่ 3 

เหล่ียมไปจนถึงจ านวนเหล่ียมมากกวา่ 10 ดา้น กส็ามารถท าได ้เคร่ืองมือวาดรูปทรงหลายเหล่ียม คือ Polygon 

การวาดรูปทรงหลายเหลีย่ม  

เคร่ืองมือ   Polygon โดยมีวธีิสร้างดงัน้ี 
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การแก้ไขรูปทรงด้วยหน้าต่าง Entity Info  
เราสามารถแกไ้ขรูปทรงที่ไดส้ร้างไปแลว้ ดว้ยการเรียกหนา้ต่างคุณสมบติัของรูปทรง หรือ Entity Info ตามขั้นตอน

ต่อไปน้ี 
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เคร่ืองมือวาดเส้นโค้ง Arc 

การวาดเสน้โคง้จะใชเ้คร่ืองมือ คลา้ยกบัการวาดเสน้ตรง แต่สามารถปรับเสน้โคง้ขนานกบัแนวเสน้ตรงที่วาดไว้

เป็นเสน้ฐานในตอนแรก โดยความโคง้มากนอ้ยนั้นขึ้นอยูก่บัระยะห่างระหวา่ง โคง้กบัเสน้ตรงที่วาด หรืออาจจะวาด

เป็นเสน้โคง้ที่ต่อเน่ืองกนัเป็นรูปทรงที่มีพื้นผวิก็ไดเ้ช่นกนั เคร่ืองมือวาดเสน้โคง้มีอยู ่4 เคร่ืองมือ ไดแ้ก่ 

การวาดเส้นโค้งด้วยเคร่ืองมือ Arc 

เคร่ืองมือ Arc เป็นเคร่ืองมือใชส้าหรับสร้างเสน้โคง้แบบก าหนดมุมได ้มีขั้นตอนดงัน้ี 
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การวาดเส้นโค้งด้วยเคร่ืองมือ 2 Point Arc  
เคร่ืองมือ 2 Point Arc เป็นช่ือเรียกใหม่ ซ่ึงช่ือเดิมก่อนเวอร์ชัน่น้ีคือ Arc เคร่ืองมือ 2 Point Arc มีหลกัการ

ท างานคือ ก าหนดเสน้ฐาน 2 จุด และขึ้นรูปเสน้โคง้ มีขั้นตอนการสร้างดงัน้ี 

 

 

 
การวาดเส้นโค้งด้วยเคร่ืองมือ 3 Point Arc  
 

เคร่ืองมือ 3 Point Arc เป็นเคร่ืองมือใหม่ในเวอร์ชัน่ 2015 หลกัการท างานคือ ก าหนดจุด 3 จุดที่อยูบ่นส่วน

โคง้เดียวกนั หากจุดเร่ิมตน้และจุดปลายเป็นจุดเดียวกนัแลว้ จะไดรู้ปวงกลม การวาดส่วนโคง้แบบก าหนด 3 จุด มี

ขั้นตอนการสร้างดงัน้ี 
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การวาดเส้นโค้งด้วยเคร่ืองมือ Pie  
เคร่ืองมือ Pie มีการใชง้านเหมือนกบัเคร่ืองมือ Arc ทุกอยา่ง เพยีงแต่ผลที่ไดค้ือส่วนของวงกลมที่เป็นพื้นที่ปิด  
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วตัถุ 3 มิต ิ( 3D Model ) 

วตัถุ 3 มิติ หรือ 3D Model คือ วตัถุที่ถูกสร้างโดยโปรแกรมคอมพิวเตอร์เพือ่แสดงผล ให้เห็นบนพื้นผิวที่ 3
มิต ิคือมีมิติในแนวนอน แนวตั้ง และแนวลึก ซ่ึงแตกต่างจากภาพ 2 มิต ิที่แสดงผลเพียง 2 แนวเท่านั้น วตัถุ 3 มิติ จึงมี
มุมมองที่มากกวา่ คือสามารถมองเห็นไดร้อบดา้น 360 องศา และสามารถปรับแต่งแกไ้ขรูปทรงในลกัษณะเหมือนกบั
งานป้ันได ้ซ่ึงเรียกวา่ 3D Modeling หรือการป้ันวตัถุ 3 มิต ิ

ส่วนประกอบ 3D Model  
วตัถุ 3 มิต ิแบบ Polygonal มีส่วนประกอบ ดงัน้ี  
1.Face : คือ พื้นผวิแต่ละดา้นของวตัถุ 

2.Edge : คือ เสน้ขอบแต่ละดา้นของวตัถุ 

3.Vertice หรือ Vertex : คือ จุดเช่ือมต่อของเสน้และพื้นผวิ 

 

เคร่ืองมือเคลื่อนย้ายวตัถุ Move 

เคร่ืองมือเคล่ือนยา้ยวตัถุม่ีช่ือว่า Move สามารถใชง้านไดม้ากกว่าการเคล่ือนยา้ยวตัถุช้ินใดช้ินหน่ึงเท่านั้น 

เคร่ืองมือน้ียงัประยุกต์ใช้ในการท าส าเนาวตัถุได้อย่างมีประสิทธิภาพ และใช้แก้ไขรูปทรงวตัถุได้ด้วยนับเป็น

เคร่ืองมือพื้นฐานและสารพดัประโยชน์ในการสร้างโมเดลช้ินงาน 

การเคลือ่นย้ายทั่วไป 

ตวัอยา่งน้ีจะเป็นการใชเ้คร่ืองมือเพือ่ยา้ยต าแหน่งวตัถุ ซ่ึงเป็นการใชง้านทัว่ไปของเคร่ืองมือน้ี คลิกที่
เคร่ืองมือ Move จากนั้นคลิกเลือกวตัถุที่ตอ้งการยา้ย  ยา้ยวตัถุ ไปยงัต าแหน่งใหม่ 

 



33 
 

 

การเคลือ่นย้ายและท าส าเนา  
ตวัอยา่งน้ีจะเป็นการใชเ้คร่ืองมือยา้ยเพือ่ท  าส าเนาวตัถุ และก าหนดระยะห่างที่แน่นอนจากวตัถุตน้ฉบบั หรือเรียกวา่ 

การท า Liner Arrays 
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เคร่ืองมือหมุนวตัถุ Rotate 

เคร่ืองมือ  Rotate ใชส้าหรับหมุนช้ินส่วนตามแกนที่ก  าหนด หากเราหมุนช้ินส่วนเดียว ก็ใชเ้คร่ืองมือ 

Rotate หมุนโดยตรง แต่ถา้จะหมุนหลายช้ินส่วนก็ตอ้งใชเ้คร่ืองมือ  Select คลิกเลือกช้ินส่วนที่ตอ้งการก่อน แลว้
จึงใชเ้คร่ืองมือ Rotate  

เคร่ืองมือ Rotate ยงัประยกุตใ์ชใ้นการท าส าเนาวตัถุแนวโคง้ไดอี้กดว้ย ซ่ึงเรียกวา่ Radial Arrays 
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การใช้ Rotate หมุนวตัถ ุ 
ตวัอยา่งน้ีจะเป็นการใช ้Rotate หมุนวตัถุ โดยมีจุดหมุนคือตวัวตัถุเอง 
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การใช้ Rotate Tool ท าส าเนาวตัถุแนวโค้ง  
ดว้ยวธีิการเดียวกนักบัการยา้ยวตัถุแนวโคง้น้ี หากเรากดปุ่ ม <Ctrl> คา้งขณะ ก็จะเป็น การท าส าเนาวตัถุไปดว้ย 

 
 

เคร่ืองมือปรับขนาดวตัถุ Scale 

เคร่ืองมือปรับขนาดวตัถุมีช่ือวา่ Scale มีหนา้ที่เปล่ียนขนาดหรือสเกลจากวตัถุตน้ฉบบัใหย้อ่หรือขยายใหญ่
ขึ้น ซ่ึงการเปล่ียนสเกลน้ีจะเป็นการเปล่ียนแปลงขนาดของวตัถุจริง ไม่ใช่การซูมขยายหรือยอ่มุมมอง  
การก าหนดสเกลที่จะยอ่หรือขยายนั้น เราสามารถใชเ้มาส์กะขนาดคร่าว ๆ หรือก าหนดค่าที่แน่นอนในการปรับได ้
และสามารถเปล่ียนสเกลในทางตรงกนัขา้ม หรือเรียกวา่ Mirroring ผลที่ไดค้ือวตัถุจะอยูใ่นทิศทางกลบัดา้น หรือ
กลบัหวักลบัหาง  

การใช้ Scale Tool ปรับขนาดโดยรักษาอตัราส่วน  
ตวัอยา่งน้ีจะเป็นการปรับขนาดวตัถุโดยรักษาอตัราส่วนของรูปทรงไม่ใหผ้ดิไปจากเดิม 
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เคร่ืองมือผลกัและดึงวตัถุ Push/Pull 

เคร่ืองมือผลกัและดึงพื้นผวิวตัถุมีช่ือวา่ Push/Pull เป็นเคร่ืองมือที่ใชป้รับแต่งรูปทรงวตัถุ ใหมี้ปริมาตร
เพิม่ขึ้นหรือลดลง มกัใชใ้นการขึ้นรูปวตัถุจากรูปทรง 2 มิต ิเช่น รูปส่ีเหล่ียม ใหก้ลาย เป็นรูปทรง 3 มิต ิคือกล่อง
ส่ีเหล่ียม เป็นตน้  

เคร่ืองมือ Push/Pull สามารถประยกุตใ์ชไ้ดม้ากมาย และนบัวา่เป็นเคร่ืองมือที่โดดเด่น ของ SketchUp ที่ท  า
ใหก้ารขึ้นรูปโมเดลนั้นรวดเร็วมาก และไม่ยุง่ยากเหมือนโปรแกรมสร้างงาน 3 มิติอ่ืนๆ 

การใช้ Push/Pull กบัพืน้ผวิทัว่ไป  
เคร่ืองมือ Push/Pull สามารถใชก้บัพื้นผวิปิดทัว่ไปได ้ไม่วา่จะรูปทรงเป็นส่ีเหล่ียมหรือโคง้ ก็ตาม  

 

 

การใช้ Push/Pull เพิม่ความซับซ้อนให้พืน้ผวิ  
ระหวา่งการสร้างปริมาตรเราสามารถเพิม่ความซบัซอ้นใหก้บัปริมาตรไดโ้ดยการแบ่ง Segments ของวตัถุ 

เพือ่การปรับแต่งรูปทรงที่ซบัซอ้นมากขึ้น 
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การใช้ Push/Pull Tool เจาะวตัถ ุ 
นอกจากจะใชใ้นการเพิม่ปริมาตรแลว้ Push/Pull ยงัสามารถใชเ้จาะวตัถุไดอี้กดว้ย ดว้ยเง่ือนไขวา่ วตัถุที่จะ

เจาะนั้นตอ้งมีพื้นผวิที่ขนาดกนั ตวัอยา่งง่าย ๆ คือการเจาะก าแพง เพือ่เป็นช่องประตู 
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 เคร่ืองมือสร้างขอบขนาน Offset  

เคร่ืองมือสร้างขอบขนานมีช่ือวา่ Offset มีไวเ้พือ่สร้างเสน้หรือพื้นผวิที่มีลกัษณะ ขนานกบัเสน้หรือพื้นผวิที่

อา้งอิง ซ่ึงประยกุตใ์นการสร้างช้ินงานได ้เช่น การสร้างขอบประตู หรือหนา้ต่าง เป็นตน้ 

 

การใช้ Offset Tool กบัเส้นและพืน้ผวิทัว่ไป  
ตวัอยา่งน้ีจะเป็นการสร้างขอบขนานจากเสน้และพื้นผวิดว้ยเคร่ืองมือ Offset  
การใช้ Offset Tool กับเส้น  
Offset Tool สามารถใชก้บัเสน้ที่ต่อเน่ืองในระนาบเดียวกนัได ้ขั้นตอนมีดงัน้ี 
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การใช้ Offset Tool กับพืน้ผิว  
Offset Tool สามารถใชก้บัพื้นผวิปิดใด ๆ ได ้ขั้นตอนมีดงัน้ี 

 

 

 เคร่ืองมือสร้างวตัถุตามเส้นทาง Follow Me 

เคร่ืองมือ Follow Me เป็นเคร่ืองมือที่มีเอกลกัษณ์ในการใชง้าน คือจะสร้างรูปทรงต่าง ๆ ไปตามเสน้ทางที่

ก  าหนด นิยมนาไปใชส้ร้างโมเดล เช่น ราวระเบียง บวัเชิงเสน้ รางน ้ าฝน ซ่ึงตวัอยา่งต่าง ๆ จะท าใหเ้ขา้ใจการใชง้าน
มากขึ้น 
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การใช้ Follow Me แต่งของวตัถุ  
ตวัอยา่งแรกจะเป็นการแต่งขอบวตัถุให้เป็นไปตามเสน้ที่เราวาด 
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การใช้ Follow Me สร้างรูปทรงด้วยการวนรอบ  
ตวัอยา่งน้ีจะเป็นการสร้างรูปทรงไดด้ว้ยการวนรอบของเคร่ืองมือ Follow Me 
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 เคร่ืองมือสร้างข้อความ Text 

เคร่ืองมือ Text เป็นเคร่ืองมือที่ใชส้ร้างขอ้ความกากบัส่วนต่าง ๆ ของช้ินงาน ซ่ึงมีประโยชน์มาก เม่ือช้ินงาน

มีรายละเอียดที่ตอ้งการบ่งช้ี ซ่ึงขอ้ความต่างๆ ไดแ้ก่ ช่ือช้ินงาน, ขนาด, พื้นที่ หรือขอ้ความอ่ืนๆ 

การสร้างและแก้ไขข้อความ  
ตวัอยา่งน้ีจะเป็นเคร่ืองมือ Text ในการสร้างขอ้ความพร้อมเสน้ช้ีไปยงัส่วนของช้ินงาน ซ่ึงมีขั้นตอนดงัน้ี 

 
 

หน้าต่างจดัการวตัถุส าเร็จรูป Components 

Component คือวตัถุส าเร็จรูปที่ไดจ้ากการวาดของเราเองและบนัทึกไว ้หรือเป็นวตัถุ ที่ดาวน์โหลดเพิม่เติม

จาก 3D Warehouse คุณสมบตัิของ Component คือสามารถเรียกใชแ้ละ วางบนพื้นที่ท  างานไดท้นัที โดยไม่ตอ้งวาด
ใหม่ทุกคร้ัง เป็นเหมือนการเรียกใชส้ าเนาของวตัถุนั้นนัน่เอง 

Components เป็นหนา้ต่างที่รวบรวม Component ต่าง ๆ ไวเ้พือ่ดูขอ้มูล และใชใ้น การเลือกแกไ้ขคุณสมบติั
ของ Component ดว้ย ในหวัขอ้น้ีจะศึกษาการจดัการ Component ดว้ยหนา้ต่าง Components 
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ส่วนประกอบของ Components  
ส่วนประกอบของหนา้ต่าง Components (เรียกใชจ้ากเมนู Window เลือก Components) จะมีส่วนประกอบ

ต่าง ๆ ดงัน้ี 

 

 

 

 

 

 

 

 

 

 

 

การเรียกใช้ Components  
การเรียกใช ้Component จากหนา้ต่าง Components มีขั้นตอนดงัน้ี 

 


